
PC Driver Setup
Prior to attempting the full procedure detailed in 
this document, the first attempt to troubleshoot 
should be done as follows:

1.	 Download driver for RNDIS Ethernet Gadget. 
Navitate to https://www.aimco-global.com/
software and click on Gen IV System Port 
Connectivity - Windows 10 RNDIS Driver. The 
driver will automatically download a Zip file 
to your PC's Download folder. 

2.	 Copy and name the folder RNDIS Driver 
and place into Documents. Unzip folder to 
Documents so it has a home on the PC that 
can be found easily

3.	 Return to Device Manager (still open from 
Step 1). Right Click on the device the PC 
assigned as a COM port in the beginning.

4.	 Select Uninstall Device and the COM port 
assigned devce will be removed

5.	 At the top of the Device Manager screen, 
click on the Monitor Icon which will scan for 
hardware changes

The device will now appear, depending on 
your PC configuration, as an RNDIS Ethernet 
Gadget or a COM port

6.	 Right click on the Device that appeared and 
select Update Driver

7.	 Click on Browse my computer for driver 
software

8.	 Click on Let me pick from a list of available 
drivers on my computer and Have Disk

9.	 Select driver from folder placed in PC 
Documents

10.	 Install driver

In Device Manager, the device should now 
appear as UDB Tehernet/RNDIS Gadget and 
connectivity will be functional.

Software Description
Torque to Spreadsheet (TTS) is an intuitive application 
that allows users to quickly connect to torque test 
stands or digital transducers through a serial or 
USB Cable. This application facilitates the display, 
collection, archiving, and processing of torque 
readings. For data export, TTS can launch Excel for 
further data analysis, reporting, and archiving.

Platform Requirements:

•	 Windows 7/8/10/11
•	 Microsoft Excel is required for Exporting Readings 

and Graphing Function
 
Installating the Software

1.	 Application is installed by simply running the 
Torque To Spreadsheet.msi file that is provided. 
Please read the Readme file before extracting 
and running.

2.	 Follow instructions on screen to finish installing.
3.	 The Driver for Cables can be installed by running 

CDM21216_Setup.exe.

Please note: ONLY install the Driver for USB Cable if 
the software fails to recognize the cable.

Application Components
Software Modules - choose the module by selecting 
the desired. Details for each tab are discussed in 
subsequent sections.

a.  Torque To Spreadsheet Tab
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This module allows the user to export the reading 
from testers directly into an Excel file (works as a 
terminal emulator). Click on “Activate Spreadsheet 
Mode.” Open an excel file and place mouse cursor 
on any cell of Excel Spreadsheet. Each reading will 
be exported into the Excel file where the cursor is 
located.

Please note: This feature currently does not work 
with digital transducers.

b.  Single Channel Tab

This module allows the user to take readings from 
one channel. User can set Target, Low Limit and 
High Limit, as a percentage or absolute value. Single 
Channel Mode also features live graphing and 
exporting of all data along with the graph into an 
Excel Spreadsheet. (User does not have to place 
cursor into a cell.)

c.  Big Reading Tab

This module displays large readings for easy viewing 
in Single Channel mode.

 

d.  Dual Channel Tab

This module has the same features of the Single 
Channel mode and allows the user to monitor and 
graph two channels almost simultaneously. This 
facilitates torque vs torque and torque vs pressures
graphs.

e.  Calibration Tab

Calibration module allows setting up Multiple Target 
Points for either Single or Dual Channel Test. Export 
the Test To Excel or Cert Manager for creating 
Certification.
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f.  Tools Manager Tab

This module allows the user to create or select tool 
files.

g.  Test Manager Tab

This module allows the user to create or select Tests 
to be used to perform calibrations.

Software Application
 
The top taskbar is consistent througout the software 
screens 

File Menu:

•	 Open: Opens pop up window for selecting 
directory and files.

•	 Restart App: restart application. All Current 
Readings will be lost.

•	 Define Quick Export Path: Define a Folder 
to Export Excel. This folder applies for Single 
Channel Quick Export, Dual Channel Quick 
Export and Calibration Excel Export.

•	 About: Copyright, version and contact 
information.

•	 Exit: exits the application.

Options Menu:

•	 Always on Top: Keep this Application on Top of 
other Applications.

•	 Time Date Stamp: Include Time and Date along 
with the Readings-only works in Torque to 
Spreadsheet.

•	 Show ALL COM available: only turn on this 
Option if the software is unable to find the 
connected device.

•	 Enable Live Reading: Turn on by Default. This 
Option shows the Reading of the Tester that is 
connected to the software.

•	 Overwrite Data at Cursor: only applies for Single 
Channel and Dual Channel mode. Turning on 
this option will record Reading to the Row that 
user is currently selecting on Grid View.

•	 Force Auto-clear: Forces the device to 
AutoCLR captured reading.

•	 Auto Update: If application is connected to the 
internet and company IT department allows 
the application will automatically update.

•	 Check for Update: If connected to the internet 
sends a query to our system for any updates.
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Torque To Spreadsheet

This is the most basic application module that allows a user make use of Spreadsheet Mode.

Functions
1.	 Shows the current COM Port connected and full scale of the 

tester that is connected.
2.	 Shows live reading and measurement units of the tester that 

is connected.
3.	 Shows list of available testers that can be connected to the 

TTS Application. To connect to a non-intellect tester, go to 
Options → Turn on “Show All COM Available.”

4.	 Refresh available COM list.
5.	 Open or close Channel 1.
6.	 Select how many sets of Readings (per row) before the 

cursor moves to next row in the Excel spreadsheet.
7.	 Reset the Count for readings per row.
8.	 Start or stop Spreadsheet Mode that parses data from the 

tester to an Excel spreadsheet.
9.	 Send Reading Only. User can select Reading only or Memory 

Location, Reading, Engineering Unit, Date and Time if 
available to Excel.
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Single Channel

This TTS module allows the user to define Target, Low Limit, and High Limit. This option populates captured 
readings into the graph using the defined Target and Limits. Exporting to Excel will also place the graph into the 
spreadsheet.
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Functions
1.	 Shows the current COM Port connected and full 

scale of tester that is connected.
2.	 Shows live reading and measurement units 

of the tester connected. If connected to an 
intellect tester, the user can also control the 
tester using the TTS application. This is where the 
user can send parameter setup commands to 
the tester - Unit, Mode, Menu, Zero/Clear.

3.	 Shows list of available testers that can be 
connected to the TTS application. To connect 
to a non-intellect tester, go to Options → Turn on 
“Show All COM Available.”

4.	 Refresh available COM list.
5.	 Open/close Channel 1 Connect or Disconnect 

the tester.
6.	 Define a target. This target applies to all readings 

taken in this module.
7.	 Define Low Limit, by selecting from % of Target 

or absolute limit value. This limit applies to all 
readings taken in this mode.

8.	 Define High Limit by selecting from % of Target 
or absolute limit value. This limit applies to all 
readings taken in this mode.

9.	 Shows the name of Current Run. User can also 
change the Current Run name from here.

10.	 Save & Open or Save As and Open exports the 

Current Run readings to Excel (see image on 
following page). The Excel file will be saved under 
the Quick Export Path or destination of User's 
choice (See File → Define Quick Export Path). 

11.	Export the Current Run Readings to Excel. This 
option allows the user to choose the specific 
path to Save, instead of default to Quick Export 
Path.

12.	 This grid view shows the recorded readings for 
current run.

13.	Delete the current row that is selected on 
Current Run’s grid view.

14.	Clear all the data in Current Run’s grid view.
15.	Save the Current Run Reading into Recent Run’s 

grid view on the right.
16.	New Run saves Current Run into Recent Run grid 

view and starts new current Run.
17.	Live graph showing Target and Low/High Limits 

(dotted green and solid red horizontal line).
18.	Similar to functions described in points 9, 10, and 

11, but covers the complete test (including all 
the saved runs and current run).

19.	Shows the readings for all saved runs.
20.	User can change the names of all saved runs.
21.	User can delete saved runs (Current Run cannot 

be deleted). To clear the current run, use the 
Clear All Data button under Current Run table.
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Big Reading Tab
 
This TTS module changes the display so that users can easily see readings and Pass/Fail when conducting a test 
in Channel 1. There are multiple "buttons" for Size +, Size -, Low Limit, High Limit, and Target. The display has Pass/
Fail and Refresh COM List and Open/Close Channel 1 to facilitate communication.

Current readings exported to Excel
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This TTS module allows user to define Target, Low 
Limit, and High Limit in the spreadsheet just like 
previous module, but a user can connect up to two 
inputs. This option populates captured Readings 
into the graph using the defined Target and Limits. 
Exporting to Excel will also place the graph onto the 
spreadsheet.

*Notes:
•	 When both Channels are connected, pressing 

Enter or Capture on Channel 1 will also capture 
Channel 2.

 Dual Channel

•	 To capture Channel 2 without having to connect 
a tester to Channel 1, simply type in a new 
Reading for CH1 in the grid view.

•	 Each test can consist of many tuns. The default 
name for first run is "Reading."

•	 Each run consists of Channel 1 readings and 
Channel 2 readings. The default names for them 
are "Reading-CH1" and "Reading-CH2."
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Functions
1.	 Shows information of tester/transducer and live 

reading that is currently connected to Channel 
1.

2.	 Show information of tester/transducer and live 
reading that is currently connected to Channel 
2.

3.	 Choose whether the Channel is graphed as X 
axis or Y axis. This setting cannot be changed 
after saving the first run.

4.	 Shows available testers/transducers that can be 
connected.

5.	 Shows Current Run reading for Channel 1, as 
long as the Current Run Name is selected.

6.	 Shows reading of Current Run for Channel 2, as 
long as the Current Run Name is selected.

7.	 Export the Current Run Readings to Excel. This 

option allows user to choose the specific path to 
Save instead of defaulting to Quick Export Path.

8.	 Export the Current Run Readings to Excel. The 
Excel file will be saved under the Quick Export 
Path. (See File → Define Quick Export Path.)

9.	 Save the Current Run Readings into Recent 
Run’s grid view on the right.

10.	 Save "Archive" Current Run into Recent Run Grid 
view and start new current run.

11.	Deletes the current row that user is selecting on 
Current Run’s grid view.

12.	Clear All the Data in Current Run’s grid view.
13.	Shows the live graph for all runs.
14.	Shows readings of all saved runs, along 

with option to export all runs into an Excel 
spreadsheet.
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The calibration module allows user to create a New Test or to select an existing Test in the Test Set Up window.
User can enter the Test ID, Test Type, # Points, Target Fullscale, Capture Angle, Test Order, (As Left CW, As 
Found CW, As Found CCW, As Left CCW), # Samples/point, Low Limit, High Limit, % or Eng. Unit, Channel 1 Unit, 
Channel 2 Unit sequences with multiple Targets, and Low/High Limits. After selecting or identifying a test, a user 
can Run Test and export data to Excel or to Cert Manager application (also included if purchased with SMD-
Dual package).

The user can also select or create Tool information. The information includes Tool Name, S/N, Recall Interval, 
Temperature, Humidity, Model, Manufacture, Cert Lot, Procedure, Operator ID, and Comments. Fields in Bold 
are required to be filled in.

Cal Cert
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Functions
1.	 Test Set up: If this window is enabled, it indicates 

that the application is currently in Test Setup 
Mode. Fields in Bold and with an * are required 
to be filled in before being able to start a test.

	○ Select Test*: Select existing Tests, (default 
Tests are indicated by the double asterisk. **) 
or create a New Test:

	▪ 3 points**: 20%, 60%, 100% of Full Scale
	▪ 5 points**: 20%, 40%, 60%, 80%, 100% of 

full scale
	▪ 5 points and 10%**: 10%, 20%, 40%, 60%, 

80%, 100% of full scale
	▪ 5 points 5% and 10%**: 5%, 10%, 20%, 

40%, 60%, 80%, 100% of full scale
	▪ 10 points**: 10%, 20%, 30%, 40%, 50%, 

60%, 70%, 80%, 90%, 100% of full scale

	▪ 10 points and 5%**: 5%, 10%, 20%, 30%, 
40%, 50%, 60%, 70%, 80%, 90%, 100% of 
full scale

	▪ 20 points**: 5%, 10%, 15%, …, 95%, 100% 
of full scale

	○ Test ID*: Name of the Test.
	○ Test Type*: Either Single or Dual Channel Test.
	○ # Of Points*: Indicates how many targets 

there are. Unless it is one of the Default Tests, 
Users' custom Test Targets will be full scale 
divided evenly by the # of points.

	○ Target Full Scale*: Indicates full scale of 
tester.

	○ Capture Angle: Select channel that will have 
Angle captured, if the tester connected 
support Angle.
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	○ # Samples/points*: Indicates how many 
samples will be taken for each Target Point.

	○ Low Limit*/High Limit*: Define the limit that will 
determine whether the readings pass or fail.

	○ % or Eng. Unit*: Select whether the limit 
values are a percentage (%) or a specific 
numerical value from Target.

	○ Channel 1 Unit/ Channel 2 Unit: Will 
automatically sync up with Tester once 
connected. User doesn’t need to fill out this 
field.

	○ Test Order: User can select which quadrant 
of the test to run and in which order.

	○ Save As: Save the current Test as a New Test.
	○ Reset: reset all values to the original Values 

of the Test. Please note that if a Test was 
changed and saved, it will only revert back 
to the values AFTER the last Save.

2.	 Enter tool information in Tools Info window. This 
information will populate Cert Manager.

3.	 Shows listing of available testers/transducers that 
can be connected.

4.	 Live Reading of Testers/Tranducers that are 
connected to Channel 1 and Channel 2.

	○ Angle: Shows Angle for testers that support it.
	○ Trough Mode: Can only be activated in Dual 

Channel Test and should only be used for air 
tools.

5.	 Save Average ONLY to Cert Manager: in 
case there are more than 1 # Samples/point, 
checking this option will export only Average 
values for each test target to Cert Manager.

6.	 Copy All: This option is only available in Test 
Setup Mode. All Low, Target, High values from As 
Found-CW quadrant will be copied to the other 
four quadrants when clicked.

7.	8.9.10: Shows All Test Points that will be taken for 
this Test. Target, High, and Low column can be 
edited manually while in Test Setup Mode, but 
not during a test. As Found readings can also 
be copied over to As Left reading by using the 
Copy button.

11.	Save & Open Excel: Export current readings 
to an Excel spreadsheet, along with Tool Info. 
Please note that this Excel export CANNOT be 
read by Cert Manager.

12.	Delete Last: Delete the most recent reading that 
was taken.

13.	Clear Readings: Clear all readings. Ready for 
new test.

14.	New Test: Clear all the readings and go back to 
1.Test Set up.

15.	Save To Cert: Save the current test into Cert 
Manager. Please make sure to press Import Cert 
after opening Cert Manager to update any new 
Cert.

16.	Open Cert: Open Cert Manager Application.



10

SMD Torque to Spreadsheet Software User Manual

Tools Manager allows 
user to select or 
create a tool profile 
and then associate a 
Test with the Tool.

User either selects a 
Tool file or clicks on 
New to create a new 
tool file. The Tool ID 
is required, all other 
fields are optional. 
After selecting or 
creating the Tool file 
user can associate or 
create a Test file for 
this specific tool.

Tools Manager

1.	 Select Tool ID file name or
2.	 Click on New to create a new Tool file.
3.	 Tool ID/Name is required, all other label fields are 

optional at this point.
4.	 Select Torque Mode for Ch 1 and Ch 2 if running 

Dual Channel.
5.	 Select whether to force Operator ID (Scan 

Operator).
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6.	 Select whether to force a pause to make 
adjustments to the tool being tested.

7.	 Select whether to Save or Save As. Save saves 
file in Quick Path, Save As allow user to save in a 
different path/ location.

8.	 User can select a Test file to associate with the 
Tool or create a New Test file.

9.	 Test Managers launches full Test Manager 
module.
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Test Manager
 
Test Manager allows user to select or create a test profile. User either selects a Test file or enters a new Test ID name.

1.	 Select Test ID file name
2.	 Use Up and Down buttons to scroll through file 

names.
3.	 Select Delete, Save & Close or Cancel.
4.	 Enter Test Set up Test to edit or create new test 

file. ID/Name is required as is all bold label fields. 
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5.	 Select As Found CW, As Left CW, As Found CCW, 
As Left CCW.

6.	 Save Test or Save As New.
7.	 Reset Fields.
8.	 Copy All. Copies data into all quadrants.
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